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Chapter 1

Preliminaries about Maple

Maple is a comprehensive general purpose computer algebra system which can do symbolic and
numerical calculations and has facilities for 2- and 3-dimensional graphical output. Calculus
courses may be structured so that Maple can be used as a tool that will help you gain a complete
understanding of the material discussed. You will discover that the capability of Maple goes
well beyond the realm of calculus; it is a tool that is used more and more in education and
scientific research in mathematics and engineering.

This chapter is a brief introduction to the use of Maple in the environment that you will
discover at Stony Brook. It is not exhaustive and its sole purpose is to guide you through the
first steps needed to start using this tool. Once you become familiar with the basics of Maple
and can appreciate its advantages, we encourage you to experiment with it, not only to learn
mathematics in more detail but also to help you in other courses and your own research. More
advanced documentation is available on line, in the computer lab, and in the library.

Maple runs on many different types of computers and operating systems. For example, you
might use Maple from a Sun workstation running Solaris (a flavor of Unix) in the computer
lab, from a Windows computer in the library, and from a Macintosh at home. Maple behaves
similarly on all of them; we will usually point it out when we use something specific to one type
of computer.

1 Starting a Maple Session

How to start a Maple session varies somewhat in different enviroments. On the Windows
machines, you can usually either start Maple by selecting the option from the start menu, or
by finding the appropriate icon (it usually looks like a Maple leaf) and clicking the mouse on it.
In a Unix environment, there may be an icon or menu item for Maple; you can usually always
just issue the command xmaple & or maple -x & to start it.

After a brief pause, you should see a window that looks similar to that in Figure 1; this
is Maple’s graphical (or worksheet) interface, where you will type your commands and see the
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Figure 1: A newly-opened Maple worksheet.

results. We will go into more details of the worksheet interface in §3. As in the figure, you're
session may have started with two windows open inside the main Maple window. The one
in front in Figure 1 is a help window; we’ll come back to this in §3.3. But for now, let’s
concentrate on a worksheet where we can enter some Maple commands. The top part of this
window should look something! like this:

||~| Untitled (1) - [Server 1] =l

This window is a Maple worksheet, and is a place to enter your Maple commands. For now, click
on the button which maximizes the current worksheet; this is on right side of the worksheet’s
title bar, and looks like .2 Clicking the mouse on this should make the worksheet fill most of
the Maple window.

Most users typically use the Maple’s graphical, or worksheet, interface; this is what starts
you add the -x to the maple command in Unix. However, there is also a text-based interface,
which you might see if you just type maple, omitting the -x.

LThis particular image was made on a computer running Unix. Under Microsoft Windows or on a Macintosh,
the symbols around at the edges will be slightly different, but with similar functions.

2Again, if you are running another type of computer, the button may look a little different. For example,
under MS-Windows, it looks similar to this: &I,
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N~/ Maple V Release 5.1 (SUNY Stony Brook)
I\ |/1_. Copyright (c) 1981-1998 by Waterloo Maple Inc. All rights
\ MAPLE / reserved. Maple and Maple V are registered trademarks of
< > Waterloo Maple Inc.

| Type ? for help.

This interface is useful when you want to run Maple in a non-graphic environment; for example,
over a dial-up connection. However, keep in mind that while all the usual Maple commands
work, this interface is much more limited— it is difficult to edit your commands or save your
work, and graphic commands such as plot are much more limited. If you get into this mode
by mistake, you can just type the Maple command quit; to exit.

2 Basic Maple

You can use Maple for numerical calculations, for symbolic manipulations, and for graphing
purposes. All Maple commands must be ended with a semicolon ; and the corresponding stroke
of the return key. To familiarize yourself with it, try to run the following examples and analyze
the results. The commands that you type in and the Maple results are shown here in a way
that is similar to what you see on the screen.

2.1 Maple for numeric calculations

Most of the time you will be using Maple as a calculator. You can also write programs in
Maple, but usually you will be using the tool expecting an immediate response. You type in
your statement at the Maple prompt > and Maple responds with an answer:

> 1/2+3;

7
2

The symbols for the basic operations are +, -, * and /. Exponentiation is denoted by ~:
> T7*(3°5+57°2)/(99-47);

5159
13
77(3% 4 52
In the first example, the inverse of 2 is added to 3. In the second, we input ﬁ,

and Maple computes its value before printing the output.



1:4 CHAPTER 1. PRELIMINARIES ABOUT MAPLE

You must always use the asterisk * for multiplication. Forgetting it in expressions like
sin(2*x) or 4*x is easy, and may result in a syntax error message. Even if you don’t get a
syntax error, Maple will not treat the expression as you expect.

Maple works primarily with whole numbers or fractions. However, you can force it to write
the decimal expansion of any number with evalf:

> evalf (100*Pi);
314.1592654

> b:=sqrt(2);

> evalf(b);
1.414213562
> evalf(b,47);

1.4142135623730950488016887242096980785696718754

Be careful with this example. The assignment of the variable b to v/2 is done with := rather
than with =. This will be the case of any other assignment operation you do in Maple, as we
discuss below. The equals sign = is used to signify that two things are equal, not to set one to
the other.

Notice the difference in the following two examples:

> sum(1/(2*1),i=1..10);

7381
2040

> sum(1.0/(2%i),i=1..10);

1.464484127

In both cases, we compute Zgl (24)~'. However, in the second case, the presence of 1.0
indicates to Maple the terms in this computation are approximate, and gives you a decimal
expansion of the result.
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2.2 Maple for symbolic manipulations

We can ask Maple to give us a formula for the sum of the cube of the first n integers:
> sum(i~3,i=1..n);

1 1 1
- 14__ 13 - 12
4(n+ ) 2(n—l— ) +4(n+ )

We can ask to factor the resulting polynomial in n:
> factor(%);

1 2 2
- 1
" (n+1)

In this example, Maple’s “ditto operator” % is used® to refer to the result previously obtained.
Thus, in effect, the example above is equivalent to
> factor(1/4x(n + 1)°4 - 1/2x(n + 1)°3 + 1/4%(n + 1)°2);

1
ZnQ(n +1)?

One can expand or factor conveniently:
> p:=(x+1) "4*(x-6)"3;

pi= (o + 1)\ - 6)"
> expand(%);

27 — 1428 + 422° + 1122* — 28723 — 88242 — 7562 — 216

> factor(%);
(x + 1)4(£U —6)3

We can use Maple to solve equations (if b still has the value /2 from the previous section, first
unassign it by executing the command b:=’b’):

3In Maple V release 4 and earlier, Maple used the double-quote " to refer to the result of the previous
command instead of %. If you encounter an older Maple program, you might have to change this, among some
other things.
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> quadeq:=a*x”2+b*x+c;
quadeq = ax® + bz + ¢

> solve(quadeq=0,x);

V2 — /2 — dac

a

V2 + /2 — 4ac

a

1—
2

N | =

Notice that solve provides both roots of the quadratic polynomial.
Maple also divides polynomials. Here the command you execute has a syntax which is a
little bit more complicated. Consider the following example:*
> p:=x"10-1;
q:=x-1;
divide(p,q,b);

p:=x0—-1
qg=z-—1
true

We assign the polynomials 2! — 1 and z — 1 to the variables p and g, respectively, and
then ask Maple to divide p by q.° Maple replies with the statement true to indicate that the
polynomial ¢ = & — 1 divides the polynomial p = x'° — 1 exactly, and places the quotient in the
third argument of the divide command. Thus, if you want to know the value of the quotient,
you must see what the variable b stands for now:

> b;
AL R L R R Ny iy gy |

Of course, the answer produced by divide will be false if the polynomials do not divide
each other exactly. Then one can use the commands quo and rem to find the quotient and
remainder of the division:

> r:=x"2+2%x+3;

“In the worksheet interface, we can insert linebreaks by holding the shift key and the return key simultane-
ously. Maple does not execute what we type until we hit the return key unshifted.

50f course, we could have done all of this in a single Maple command divide(x~10-1, x-1, b); if we had
no intention of using p or q again.
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ro=x>+2z+3
> divide(p,r,c);
false
> quo(p,r,x);

2 — 227 + 28 + 425 — 112* + 1023 + 1322 — 562 + 73

> rem(p,r,x);

—220 4+ 22x

We would have obtained an error if we would have tried divide(p,r,b), trying to place
the quotient of the division in the variable b: it is no longer a variable since it has a value from
the previous example:

> divide(p,r,b);

Error, wrong number (or type) of parameters in function divide
The above command is equivalent to divide(p,r,x"9+x"8+x"7+x"6+x"5+x"4+x"3+x"2+x+1),
which makes no sense at all. If we insist on calling the result of the division b, it would have
been necessary to unassign the value of b first:

> b:=’b’;

b:=10

We could also have done this within the command itself, using divide(p,r,’b’).® Further
discussion on this is given in section 4.2.

We can use solve for systems of equations. For example:
> solve({1*x+(1/2)*y+(1/6)*z =1,
(1/2)*x+(1/6) *y+(1/24) *z =0,
(1/6)*x+(1/24)*y+(1/120)*z =1}, {x,y,z} );

6In both cases, it is very important to use the proper quotation marks; using " or ¢ means a very different

thing, and would not work. The quotation mark used here is the ‘single quote’ or ‘right quote’, and on most
keyboards is on the same key as the double quoute, near the enter key.
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{z =39,y = —216, z = 420}

Maple also solves inequalities:
> solve(x"2-4*x-7>0,%);

RealRange(—oc, Open(2 — v/11)), RealRange(Open(2 4+ V/11), o)

> solve(abs(1-x"2)<1/2,x);

RealRange (Open (—?) , Open (—g)) , RealRange (Open (?) , Open (?))

2.3 Graphing in Maple

Let us now use the graphics facilities of Maple. It is quite straightforward to draw the graph

of a simple expression. For example, to graph the function sin(z?) over the range —3 < z < 3,
we do the following.

> plot(sin(x~2), x=-3..3);

(R N I AN

Notice that within the worksheet interface, clicking the right mouse button on the displayed
graph causes a menu to pop up that allows you to change some of its properties. Clicking the
left mouse button causes a box to appear around the graph and the buttons on the toolbar to
change. You can use the box to resize the graph, and the buttons to change attributes such as
the style of the axes and the aspect ration.

In section 9 we shall discuss in further detail the graphing features of Maple.
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3 The Maple worksheet

Maple’s graphical interface allows you to keep a collection of commands and their results in
one place, to save your work, and resume previous sessions. You can also add comments and
text to your worksheet, to make it more readable and to describe the process of solving the
problem. It also enables you to structure your worksheet into sections of related items.

3.1 Introducing the worksheet

As we have seen, you enter Maple commands at the > prompt, and the results appear in your
worksheet. If you go back and change a Maple command and re-execute it, the result in the
worksheet changes.

At the top of the screen is a menu bar (with entries like File, Edit, and so on): clicking on
each of these words gives you a menu which allows you to affect your session in various ways.
For example, clicking on the File menu and selecting Save will allow you to save your current
worksheet for later use; selecting Open from the same menu allows you to load an existing
worksheet.

File Edit View Insed Format
Dlslell]
[x[&] [21]

Figure 2: The menu bar, button bar, and context bar.

faiesl Opfions  Window Help

2151 (Fhe] GHE HH B FRIN )

Below the menu bar is a collection of buttons which are short-cuts for items found on the
various menus. Clicking on one of these is much quicker than searching for the command on
the proper menu. For example, the button that looks like a floppy disk () saves the current
worksheet, and the magnifying glasses (IE[2I&]) adjust the zoom factor (or magnification) of
the current worksheet. The stop sign interrupts a computation, which is very useful if you ask
Maple to do something that takes a very long time, such as to find the factors of 2190 — 1.

Below this is the “context bar”, which changes depending on what kind of item you currently
have selected. For example, as mentioned in §2.3, when graphics are selected there are buttons to
adjust the style of graphics (points or lines for 2-dimensional graphics, shading on 3-dimensional
graphics), axes style, and so on. When a text item or comment section is chosen, selections for
typeface, centering, and so on appear.

3.2 Worksheet basics: the front-end and the kernel

It is important to remember that the worksheet is only a record of a Maple session, not the
session itself. Since you have the ability to edit and reorder it, it can sometimes appear to
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contain inconsistent information. Here is a small example:

First, suppose we issue the following commands:

> one:= sin(x)~2 + cos(x)"2;
one := sin(z)? + cos(x)?

> diff(one,x);

The command diff (one,x) asks Maple to compute the derivative of the expression called one
with respect to the variable x. The result is, of course, 0 because sin® z + cos? z is a constant.

Now, we go back and change the + in the definition of one to a -, and execute the statement.
However, we do not execute the diff command. Our worksheet now looks like this:

> one:= sin(x) "2 - cos(x)"2;

2 2

one := sin(z)* — cos(z)

> diff(one,x);

This seems to contain an error (the derivative should be 4sin(z) cos(z)). Obviously, this
is because we we didn’t execute all the statements. If you place your cursor on the line with
diff (one,x) and hit the return key, the worksheet will be correct again.

This may seem like a silly discussion, but this apparently obvious example is to make an
important point: Maple only “sees” your commands in the order you execute them, not in the
order you see them in the worksheet. Also, if you load a worksheet from a previous session (or
made by someone else), any assignments and results will not be accessible to the Maple session
until you execute those statements, even though the results appear on your screen.

To help you understand why this is, we point out that a Maple session typically consists
of two processes (or programs) which communicate with each other: the Maple kernel and the
“front-end”, or user interface. The front-end is the part that interacts with the user, accepting
your commands, showing the results of your computations, and so on. The kernel is the part
that does the actual computations. In certain situations (for example, when using a “parallel
Maple kernel”), it is possible to have more than one Maple kernel associated with the same
front-end.
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3.3 Online Maple help

Maple has an extensive and very useful online help system, containing information on all of
the commands, as well as a number of tutorials and example worksheets.” Spending some time
exploring the help system is well worth the effort. There are a few ways to get into the system;
one obvious one is to select from the Help menu (on the right of the menu bar). But if you
know the specific item you want help on, you can also do this in a quicker way.
Suppose you want information on Maple’s factor command. Enter the Maple command
> 7?factor
(here the semicolon is optional). Then Maple creates another window that very likely will
contain more information than you really need or care about. You can read all or part of the
information displayed in this window by moving the text down with the scroll bar to the right
of the window. You can also click in the help window, and use the arrow keys on your keyboard.
You should notice that at the end of the help window you will find a good set of examples
on the uses of the command you are inquiring about. This examples can be copied and pasted
in your worksheet and executed. In this way, you can see what the command really does.
Usually there is also a section labeled “See Also”, which points you to related commands.
Each of these words is a link to another help page. It works like a web browser: clicking the
underlined word takes you to the help page on that topic.® You can use the back button (&)
to return to the previous help page.

—| factor B
Example Workshe Algebra...  EMIExpression Manipulafil=5 e (e L1 0 AFactor
Graphics... Basic Mathemati Polynomials... AFactors
Help Guide Calculus... J Rational Expressions | Nomm Berlekamp
Index... Differential Equal Power Factor
Introduction Discrete Mathem Powmod Factors
Evaluation... Primfield factor |
Mew User’s Tour Financial Functior Simplifying... factors
Programming... Finding Roots, Fa Trace splits

# # A

Figure 3: Maple's help index.

At the top of each help page is the help index (see Fig 3), which is a table of contents for
the entire help system, organized by topic. You can use this to browse for commands you might
not otherwise have known about.

Finally, on the Help menu are entries called “topic search” and “full text search”. The first
looks for help on a specific topic, and the latter searches the text of every page in the help
system for the word you ask. Both of these can be valuable resources when used properly.

"There is even help on the help system. Select Using Help from the Help menu, or give the command
7helpguide.

8If you prefer, holding the Control key while clicking on the link opens the page in a new help window,
allowing you to view both at the same time.
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3.4 Documenting and structuring your worksheet

Aside from the great advantage of making it easy to keep track of your commands and their
results, the worksheet has some features of a word processor, allowing you to insert comments
and text which describes your solution (or anything else you like). This can be very important,
especially if you intend to show your worksheet to someone else (or even look at it yourself
later).

To enter text into a worksheet, click on where you’d like it to go, and hit the text-mode
button (it looks like [H). Note that this button will convert a Maple input region (that is, one
with a > prompt) to a text region— you’d probably prefer to insert your comments rather than
change your commands to comments. To do this, either click before the > prompt, or select
Paragraph...Before from the Insert menu.

In the text region, you can type whatever you like, using the context bar to adjust formatting
such as the typeface, centering, etc. You can even include mathematical expressions in your
text: click the “math input” button (El)° and type the Maple expression for the math you
want. When you are done, use the text-mode button to return to entering text. You can also
paste the output from a previously executed Maple command into the text area.

The worksheet interface also allows you to group parts of your worksheet into sections.
These sections can contain paragraphs and Maple execution groups, and subsections. You can
recognize a section by a large square bracket to the left, with a box at the top of it. Clicking
on the box collapses the section, showing only the its title. Collapsing all sections allows you
to see the structure of your document in outline form. To expand a collapsed section, click on
the box next to the title.

For an extensive description of how to document and structure your worksheets, see the
“Documenting your Work” section in the online help. This can be invoked with ?documenting.

4 Assignments, Functions and Constants

Let us discuss the syntax of some basic Maple commands, as well as some functions and
constants that Maple knows.

4.1 Assignment statements

The assignment is the most basic and used of Maple statements. It allows you to give names to
expressions you want the computer to remember for later use. It has the colon-equals format

name := expression. The thing on the left side of := is a name, i.e. a sequence of letters
and digits that begins with a letter. Certain names must be avoided because Maple uses them
for special purposes (see section 4.4):

90r select Math Input from the Insert menu.



4. ASSIGNMENTS, FUNCTIONS AND CONSTANTS 1:13

> a:=3; b:=5; c:=22/7;

a:=3
b:=5
c:=22/7

Now you can use a, b and ¢ as though they are numbers. Thus, we have

> atb;
8
>  c*a;
@
7
> a-b"2;
—22

4.2 Variables and subsequent assignments: unassignments

If you type a variable name and a semicolon, Maple will tell you what the variable stands for:

> C;
gg
7
> X
z

If you specify y as an expression involving x and then assign a particular value to x, this
value will get substituted into y:

>  y:=sqrt(x+3);
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y:=vzr+3
> x:=sin(w);
x := sin(w)
Y
sin(w) + 3

If x gets changed, then y will also change. Maple remembers the original definition of y:

> x:=cos(u);

T =Cosu

veosu + 3

Notice that Maple evaluates x before telling you what the variable y stands for now. To
undo this kind of thing, you can unassign variables. To do this for x execute:

vVr+3

We can also tell Maple to forget entirely all assignments made so far using the restart
command.

> restart;
X5 ¥ 25
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T

Y

z

Surrounding an expression in single quotes'’ tells Maple to delay evaluation of it. This is
why x:=’x’ unassigns x— x is assigned to mean just x without any evaluation. Note that
stopping evaluation does not stop simplification:

> 'x + 2+ 57%;

x4+ 7

4.3 Functions known to Maple. How to define your own functions

Maple has all the standard mathematical functions in its library. You can make use of them
by their appropriate name. We list some of these.

e Trig and inverse trig functions: sin, cos, tan, cot, sec, csc, arcsin, arccos, arctan,
arccot, arcsec, arccsc.

e Exponential and logarithm: Maple uses exp(x) for e” and either log(x) or 1n(x) for
the natural logarithm Inz. Logarithm in other bases are also available. For example,
log[10] (x) is log x.

e Hyperbolic functions: sinh, cosh, etc.
e Square roots and absolute values: sqrt(x) and abs(x).

A much more complete list can be found by asking Maple for help on the initially known
functions; ?inifcns does this.

Of course, you will find yourself in a situation where you would like to define your own
functions. Suppose you are analyzing the expression v/1 + x2, plugging several values into it
and calculating the result. Maple does not have a built-in function to do this, but you can
define one yourself:

10Be careful! Most keyboards have three different kinds of quotation marks, and they each mean something
different to Maple. The single quote (°) delays evaluation, the double quote (") indicates a string, and the
backquote () indicates a name (similar to a string).
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> fi=x->sqrt(1+x72);

fi=x—>V1+2?

Carefully notice the syntax. f is the name of the function and is written to the right side
of :=. The function f sends the variable x to the expression v/1 + z2; this is indicated by the
arrow. The arrow -> is made with the minus and greater-than keys.

After such an assignment, you can use the name f in the same way you use other names of
functions known to Maple, e.g. exp or sin:

> £(0); £(1); £(-1); f(3*x+1);

S

V24922 + 62

We are so accustomed to the notation f(x) to refer to a function that we might accidentally
use it in Maple. Never try to define a function with an assignment like

> f(x):=sqrt(x-2);

f=x—> V-2

It seemed like this worked, but in fact, the resulting f (x) does not work as expected. You
will not be able to substitute into it or do anything you normally do with functions.!!

Maple uses parentheses ( ) to group expressions together in a convenient form as in
> 2%(x+4)"3;

2(x + 4)°

or to delimit the arguments of a function. In mathematics, we sometimes cheat and write
sin z instead of sin (x). In Maple, this is not permissible: you must always write sin(x). Nested
parentheses are permitted:

1 Maple uses this notation for a “remember table” — you can use it to set specific values for the function. For
example, if we first define f by f:=x->sin(x)/x, then asking for Maple for £ (0) will give an error, since it is
not a permissible value for the function. However, we can define f(0) = 1 with the command £ (0) :=1; after
this, £(0) will be 1, while f(z) = sin(z)/z for all other values of z.
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> f(x);

V1+ a2

>  sin(sqrt(x+2)+1n(abs(x)));

sin(vVz + 2 + In |z|)

4.4 Special constants and reserved names

Maple knows several constants. To find them out, execute the command

> constants;

false,y, 00, true, Catalan, FAIL, ®

The names of these constants are false, gamma, infinity, true, Catalan, FAIL and Pi,
respectively. Be careful! Maple is case sensitive. Therefore pi is not the same as Pi. For
example,

> cos(Pi/4);

V2
2

> cos(pi/4);

COS L
47'('

Maple also uses I to represent the complex number y/—1. Earlier versions used E for exp(1);
this is no longer the case. If you’d like to add E as a constant, you can do the following:

> E:=exp(1);
protect (E);
constants := constants, E;

E:=e¢

constants := false, vy, 0o, true, Catalan, FAIL, 7, e
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While protecting your new constant E will stop you from accidentally redefining it, adding
E to the list of known constants doesn’t really affect things very much.

There are many commands and special objects in Maple that have preassigned names. In
creating your own expressions and setting the name of your own variables, you cannot use any
of the following 30 keywords:

and by do done  elif else end fi for from
if in intersect local minus mod not od option options
or proc  quit read save stop then to union while

You can check this list for yourself using the help system by giving the command ?keywords.

Maple also starts with a large number of predefined functions and constants. Many of these
can be listed with inifcns and ininames. If you try to use one by mistake, you will receive
an error:

> gamma:=x"2+5;

Error, attempting to assign to name ‘gamma‘ which is protected

If you insist, you can use unprotect to allow you to assign to this name. But don’t do
this unless you know what you are doing; this changes the meaning of this name even when it
is used internally, and can have unexpected consequences.

5 The limit command

The limit command is used to compute limits. Its syntax is basically

> 1limit(f,x=a);
where f is a Maple algebraic expression which (in general) depends on the variable x and a is
the expression which x approaches. For example, to compute

. 3r—6
lim ——,
22 12 — 4

we execute the Maple command
> 1imit ((3*x-6)/(x~2-4) ,x=2);

1
Maple can also deal with limits which do not exist, for example lin(l) —:
z—0
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> 1limit(1/x,x=0);
unde fined

In the following exercise, we define the slope of a straight line passing through the points
(1,%1), (z2,y2), use this function to find the slope m(z) of the line passing through the points
(1,1) and (x, z?), and finally compute the limit of m(z) as x — 1:

> slope:=(x1,y1,x2,y2)->(y2-y1)/(x2-x1);
m:=x->slope(1,1,x,x72);

2—yl
slope := (z1,yl,22,y2) — Lot

m = x — slope(1, 1, z, 2?)

> limit(m(x),x=1);

Maple is sometimes unable to determine a limit or whether it exists. In such a case, it will
return nothing after you execute the limit command.

Maple computes two-sided limits. For example, if you specify the argument x=1 as in the
previous example, Maple assumes you mean that x approaches 1 from either the right or the
left through real values only (as opposed to complex ones). However, Maple can compute one
sided and complex limits also:

> limit(1/x,x=0,right);

o0
> 1limit(1/x,x=0,left);
—00
> 1limit(x*log(x),x=0,complex);
0

You can also compute limits as £ — oo and limits of functions of more than one variable:
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> limit(arctan(x),x=infinity) ;

o] 3

> limit(x/(x"2+y~2),{x=0,y=0});

unde fined

A common error is to try to compute the limit of a function f (x) when x has been previously
given a value. If you find yourself in this situation, unassign the value of x executing the
command x:=’x’;. The previous example will fail if y still has the value assigned to it in
section 4.2.

6 The diff (and Diff) command

The diff command is used to compute derivatives of Maple expressions. Its syntax is basically
> diff(f,x);

where f is an algebraic expression and x is the variable with respect to which the derivative is

taken. For example, to compute

d3r—6
dr 2 — 4"
we execute the Maple command
>  diff ((3*x-6)/(x"2-4),x);
3 5 3z — 6)x

22 —4 (g2 —4)?

You must specify the variable with respect to which you wish to take the derivative because,
almost all the time, there are constants and other parameters around:

>  diff(exp(a*x),x);

aeam

Maple knows theoretical results about derivatives. For example, even if the functions g(x)
and h(x) are not defined, Maple will give you the derivative of their product in terms of the
functions and their derivatives:
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> diff (h(x)*g(x),x);

6.1 Higher order derivatives

To compute higher order derivatives, you can of course iterate the above command:

> diff(diff(3*sin(x),x),x);
—3sin(z)

Such a command first calculates the derivative with respect to x of the expression 3*sin(x)
and then differentiates the result to obtain the second derivative. The same result can be
accomplished with either one of the following commands:

> diff(3*sin(x),x,x);

—3sin(z)
> diff(3*sin(x),x$2);

—3sin(z)

There is an obvious extension of this command when calculating more than two derivatives.
You can also calculate partial derivatives of higher order:

> diff(In(x)*exp(-2*x) ,x$3);

6—23: e—?x 6—21

—2z
2 p +6 p +12 - — 8In(z)e

> diff(exp(x)*y~2*sin(z),x,y,2);

2e*y cos(z2)
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6.2 Implicit differentiation

Maple knows how to take derivative of both sides of an equation, and, as indicated above,
Maple can also take derivatives “theoretically” even if the definition of the functions involved
are not specified. However, you must always indicate ezplicitly the dependence of the functions
on their variables. So, if you are thinking of y as a function of x, you must write y(x) in your
equation rather than just y.
Here is a typical implicit differentiation problem. Consider the equation z?y — 3y3z = 0.
Find the slope of the graph of the curve defined by this equation at the point (3,1):
> eq:=x"2%y(x)-3*y(x)"3*x = 0;
deq:=diff (eq,x);
solve(deq,diff (y(x),x));

eq = x"y(r) - 3y(z)’z = 0;
deg = 20(a) +2* (£(0)) - (e (ale)) 3’ = 0

2zy(x) — 3y(x)®
z? — 9y(z)2x

> SubS(Y(X)=1 :X=3,%) 3

=

The first command defines the equation relating x and y, the second defines an equation
deq giving the relation between x, y(x) and the derivative of y with respect to x. Using solve,
we solve deq to find the derivative as a function of x and y(x), and in the result we substitute
x=3 and y=1 to obtain the desired slope (see section 8 to learn about the subs command).'?

Maple actually has a built-in command to do implicit differentiation, implicitdiff. Thus,
we could have done this same problem more concisely using the single command

> subs({y=1,x=3}, implicitdiff(x~2y-3y~3x=0,y,x);

1

Occasionally, to make your worksheets easier to read, you may wish to have Maple display
a derivative in standard mathematical notation without evaluating it. For this purpose there

12 Again, the major caveat with the Maple derivative command is to avoid calculating derivatives with respect
to a variable that has been previously given a value. In such an instance, unassign the value of the variable
first.
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is an inert capitalized form of the diff command: Diff. The two forms diff and Diff are
usually combined to produce meaningful sentences:

> Diff(exp(x)/(1-x),x);

o e
orl—zx

> Diff(exp(x)/(1-x),x)=diff (exp(x)/(1-x),x);

0 e e N e’
orl—z 1—z (1—2z)2

This command is particularly useful to produce easy to read worksheets that involve partial
derivatives:

> f:=x"3%exp(y)-sin(xx*y);
f = 2e¥ — sin(ay)
> Diff(f,x,x,y)=diff(f,x,x,y);

83
50 sa’e¥ —sin (zy) = 6ze? + cos (zy)zy’ + 2sin (zy)y
yox

7 The int (and Int) command

7.1 Symbolic integrals

The int command is used to compute both definite and indefinite integrals of Maple expressions.
Its syntax is basically

> int(f,x);
where f is an algebraic expression and x is the integration variable. For example, to compute

3z —6
/x2_4daj,

we execute the Maple command
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> int ((3*x-6)/(x"2-4),x);

3In(z + 2)

Notice that Maple does not provide the constant of integration. You will occasionally have to
take this into account and provide your own constant.

You must specify the variable of integration. In expressions involving other parameters,
Maple assumes that you want the integral of the expression as the variable you specify changes
and that all other parameters in the expression represent constants:

> int(exp(a*x),x);

eaw

a

To compute a definite integral, the range over which the integration variable moves must
be specified:
> int(x"2%exp(x),x=0..2);

2¢* — 2
The int command in Maple has a particular behavior in certain situations:

e If Maple cannot compute the integral in closed form, it will return it unevaluated:
> int(In(sin(sqrt(x~12-5*%x"7+50%x+2))),x);

/ln(sin(\/ﬂz12 — 527 + 50z + 2)) dx

e Sometimes the integral cannot be evaluated in closed form in terms of elementary func-
tions, but the answer has a special name in mathematical circles due to its importance in
applications. For example,
> int(sin(2*x)/x,x);

Si(2x)

Here Si is the special name of one of these functions which appear frequently in mathe-
matical physics. To learn more about it, ask Maple for help on it with the command ?Si.
This will bring up a window with information about the function Si. If Maple responds
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to an integral with one of these functions, it is quite likely that the integral cannot be
evaluated in terms of elementary functions.

e Sometimes, a result may be expressed in terms of the roots of a polynomial which does
not factor over the rationals. For example,
> int(1/(x"8 +1),x);

> _RIn(z +8_R)

_R=RootOf(1+16777216_2Z8)

In this answer, the sum is taken over all roots R of the polynomial 1 + 1677721628, and
the summand is Rlog (z + 8R).

As with diff, there is an inert form Int of the integral command which can be used in
combination with int to produce easily readable worksheets:
> Int(ln(1+3*x), x=1..4);

4
/ In (1 + 3z)dx
1

> Int(In(1+3*x), x=1..4)=int(In(1+3*x) ,x=1..4);
4 13 4
In (14 3z)dz = Eln (13) =3 — 3 In (4)
1

The inert form Int is also very useful in many situations when you wish to delay the
evaluation of an integral, as we shall see below.

7.2 Numerical integration

With the evalf command, you can force Maple to apply a numerical approximation technique
for definite integration:
> evalf(Int(sqrt(1+x~10),x=0..1));

1.040899075

Notice that the we are using the inert form of the integration command, Int. This prevents
Maple from attempting to evaluate the integral symbolically and then applying evalf to the
answer. In many cases, this can save a huge amount of time, because Maple will work very hard



1:26 CHAPTER 1. PRELIMINARIES ABOUT MAPLE

1
to try to compute the symbolic form of the integral. For example, approximating / (@) gz
0

with the command
> evalf(int(exp(sin(x))),x=0..1);
took more than 10 times the amount of time needed to execute
> evalf(Int(exp(sin(x))),x=0..1);
More complicated integrals can have even more dramatic differences.

7.3 Approximations through Riemann Sums

Maple can also compute expressions that approximate a definite integral using rectangles, trape-
zoids, etc. It can also do approximations using Simpson’s rule. The only difficulty is that these
commands are contained in a separate library called student and you must load this library
into computer memory before you can use it:

> with(student):

Once loaded, you can play with it. For example, if you want to use the left sum approxi-
mation to an integral, the height of each rectangle is determined by the value of the function
at the left side of each interval. You may specify the number of intervals you wish to use. If
you do not, Maple will use four intervals by default:

> leftsum(x"4*1n(x),x=1..4,10);

Maple can also draw pictures of the rectangles used to approximate the integral of a function
on a given interval:

> leftbox(1/x,x=1..2,10);

1 1.2 1.4 x 1.6 1.8 2
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The following is the result of using the Simpson’s rule for the function xsin(z?) on the
interval 1 < x < 5. Since the number of intervals is not specified, Maple assumes four equal
intervals by default:

> simpson(x*sin(x~2),x=1..5);

%sin(l) + gsin(%) + g (; 2isin(4z’2)> + g (Z (14 24)sin((1 + 2i2)2)>

=1

7.4 Multiple integrals

Maple does iterated integrals:
> int(int(x"2*y~3,x=0..y),y=2..3);

2059
21

This is literally an iterated integral: the integral of z%y® with respect to x on the interval [0, y]
is nested inside the integral with respect to y on the interval [2, 3], in effect calculating

3 ry
/ / 2?y3dzdy .
2 Jo

8 The subs command

You have learned in the previous sections that if you assign a particular value to a variable,
Maple will remember it for the rest of the session until you unassign it. At times, you might like
to plug in some values into an expression without altering the variable (or variables) involved.

Maple has the subs command which reports the result of making such a substitution:
> y:=x+3;

y=x+3
> subs(x=2,y);

5

Notice that Maple reports the value obtained when plugging in x=2 into y without giving that
value to x or altering y in any way:
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r+3

You can make more than one substitution:

> z:=x+sin(2x*h):
subs (x=3*u+1,h=4*Pi*q,z);

3u + 1 + sin(8mq)

In this example, the first assignment is ended with a colon : to suppress the display. You
can do this whenever you want to make an assignment which you do not want to see displayed.
Then, plugging 2 = 3u+ 1 and h = 47q into the expression for z, we obtain 3u + 1 + sin (87¢q).
Notice that the values of x and h that we plug in do not need to be enclosed in braces when
issuing the command.

You should be aware of a few things when using the subs command:

e You need not fear circular substitutions:
>z

x + sin(2h)
> subs(x=2*x,z);

2z + sin(2h)

On the other hand, long chains of self-referential substitutions may produce results which
are hard to predict:
> subs(h=x,x=z,z);

x + sin(2h) + sin(2z + 2 sin(2h))

Simultaneous substitutions are made enclosing the values you plug in in braces. This is
in contrast with the left-to-right substitution above:
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> subs({h=x,x=z},z);

x + sin(2h) + sin(2z)

1:29

e In certain situations, subs will not be able to find the expression you are substituting
for if it is complicated. In those cases, try to reword your substitution request so that
Maple understands it, or break the task into several manageable ones. In other cases, you
might consider using algsubs, which allows you to substitute one algebraic expression

for another.

e subs does what is called “syntactic substitution”; it substitutes one set of symbols for
another. If you are using it to evaluate an expression with certain values “plugged in”,
using eval might be more appropriate. Here is an example that should illustrate the

distinction:

> integral := int(f(t,a), t=a..x);

/a "t a)dt

> eval(integral,{t=0,a=1});

/lz F(t.1) dt

> subs({t=0,a=1},integral);

/f((), 1)do=1.2

The seemingly nonsensical answer using subs above is because Maple interpreted the
expression as meaning int(£(0,1) ,0=1..x) — what you get by replacing t by 0 and a

by 1 without trying to interpret the expression.

8.1 Why is subs useful?

Often it is better to use subs rather than to make assignments to the variables in an expression.

For example, if
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> y:=3%x"2+5%x+2;
y:=3x% + 5z +2

and you want to compute the difference quotient (y(z + h) — y(x))/h, then you should execute
> dq:=(subs(x=x+h,y)-y)/h;

3(z + h)? 4 5h — 3z?

dq =
1 B
because if we set
> X:=x+h;
Warning: Recursive definition of name
r:=x+h

any call to y will result in
> Yy
Error, too many levels of recursion

In earlier versions of Maple, this action would have crashed your session.
On the other hand,

> x:=4;

70

is alright, but now y is a number and we cannot plug any other values of x into it. Using subs
is a better way to do the plugging in, because we need not unassign y.

9 Plotting with Maple

Let us now use the graphics facilities of Maple:
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> plot(x~2, x=-10..10);
\ 1007

80
607 J

\ 40 /

Maple displays the graph of the function z2? from z = —10 to z = 10 as requested. In the
worksheet interface, clicking the right mouse button on the graph pops up a menu with various
options which allow you to manipulate your graph, and/or change its appearance in a suitable
way. Clicking the left button “selects” the graphic, drawing a black box with “handles” around
it. You can drag the mouse button on these to resize the plot. Also, the coordinates of the
point where you clicked appear in the upper left of the worksheet. Selecting a graphic also
changes the context bar: shortcuts for manipulating the axes, aspect ratio, and plotting style
appear as buttons along the top.

The basic syntax of the plot command is

> plot(f,range);

where f is the expression to be plotted and range is the range of the parameter(s) for which
you would like to see the plot of £. In the example above, we indicated the range of x by
x=-10..10. Maple automatically chooses a scale on the vertical axis. There are many options
to the plot command; while we will mention a few of them, the on-line help system has all the
details.

Try both of the two similar plot commands below:

> plot(x"2-x, x=-1..2, y=-1..2);

plot (x"2-x, x=-1..2, -1..2);

In both cases, the plot is displayed for values of y between —1 and 2, but in the first, the
variable y is explicitly named in the command, and the vertical axis gets a label. Whenever
you are plotting an expression, the variable in the domain of the function must be specified.

9.1 Plotting several functions (or curves) on the same axes

We can plot more than one function (or curve) on the same coordinate system. Consider the
following example, recalling the slope function of the line passing through the points (z1,y1),
(72,%2), used to define the slope m(zx) of the line passing through (1,1) and (z, z?):
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> slope:=(x1,y1,x2,y2)->(y2-y1)/(x2-x1);
m:=x->slope(1,1,x,x72);

y2 —yl

lope := (z1,y1,22,y2) —
slope := (z1,y1,22,y2) = —5——

m = x — slope(1,1, z,2?)

We now define the equation of the lines passing through (1,1) and (z,2?) for z = 2,3,4,5
and plot the four lines together with the function x~2.

> linel:=m(2)*(x-1)+1;
line2:=m(3)*(x-1)+1;
line3:=m(4)*(x-1)+1;
line4:=m(5)*(x-1)+1;
plot({x~2,1linel,1ine2,line3,1line4},x=-3..6);

linel := 3z — 2
line2 :=4x — 3
line3 :=5x — 4
lined :=6x — 5

30

20

10

Observe that the expressions to be plotted are enclosed in braces { }. Besides specifying the
range on which x varies as done above, you can also specify and label the y range proceeding
exactly in the same manner as when plotting a single function.!?

13We could have done this all in a single plot command, either explicitly typing each of the lines, or using
seq to generate them: plot({x~2, seq( m(i)*(x-1)+1, i=2..5)}, x=-3..6);
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9.2 Fancier plotting

The plot command is very powerful, and you should look for details about it using the online
help facility; the command ?plot will bring this up. There are also several related pages, and
some instructive example worksheets that are well worth looking at.

To make you aware of some of its features, we will discuss a few of them here:

e [t is possible to have Maple plot points. This can be done in two ways depending upon
how the points are generated. If you have a list of specific points, you can assign them to
a name and then plot them as follows:

> points:=[[1,2],[1.5,1],[2,-1],[2.5,0.5]1,[3,1],[3.5,0.6]1,[4,0.2]1]:
plot(points,style=POINT);

If style=POINT is replaced by style=LINE, the dots will be connected by segments of
lines. In the worksheet interface, you can switch from one style to the other by first
clicking the left mouse button on the graph, and then hitting the relevant button on the
buttonbar.

On the other hand, if the points result from evaluating an expression at several values of
X, you can use plot in its usual form, but specifying style=POINT:

> plot(x~2,x=-2..2,style=POINT);

Approximately 50 points will be plotted this way. You may notice that they will not
usually be equally spaced, but concentrated in areas where the graph curves more. You
can insist that more points be plotted by using the numpoints option:

> plot(x~2,x=-2..2,style=POINT,numpoints=150) ;

e Several more specialized plotting functions are contained in a separate library called
plots. For basic plotting, there are two commands from this library that are especially
useful. They are textplot and display. To load these commands into the computer
memory, execute the statement

> with(plots,textplot,display);

The display command is useful to combine different kinds of plots into one picture. You
can merge standard plots of expressions, plots of points, plots of text (This is the utility
of textplot: to label things), and animations. In the next example, we combine the
point plot of the variable points defined above with a plot of sin(3*x). We first define
them as different plots and then display them together. Note that except for the third
command, we end with a colon (:) in order to suppress the Maple output.
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=plot ([points],style=POINT):
=plot (sin(3*x) ,x=0..4):

> plotl:
plot2:
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display({plotl,plot2},view=[0..4,-1..2]);

18
16
14
12

08
06 /

/
0.4 /
02

-02 \
o4 \\
06
-08

The view option controls the horizontal and vertical ranges to be displayed.

You can attach labels to your plots by combining textplot with display. The basic
syntax of textplot is to use it with an argument of the form [a,b, ’name’] which places
the word name inside the quotes on the plot so that it is centered at the point (a,b). For

example:

> yi=(14x"2)*exp(-x"2/2): d:=diff(y,x):

F:=plot ({y,d},x=-3..3):
G:
display({F,G});

//K\\E;,/// N\

=textplot ({[1,1, ’function’],[0.75,0.45, derivative’]}):

-

- functibn
\

\

derivative

We end with a word about plotting functions (as opposed to expressions), and a situation

in which it is a good idea to do so. Sometimes

you will have a relationship that you want to

plot in the form of a function rather than an expression:

> fi=x->x"3*exp(-x):

In this situation, you can plot f(x) as explained above. Alternatively, you may use:
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> plot(f, 0..3);
The two ways of plotting a function should not be confused. Neither of the following two

statements will work correctly:
> plot(f(x), 0..3);

Plotting error, empty plot
> plot(f, x=0..3);
As you see, the first gives an error; the second gives a plot with nothing plotted on it.

If you have a function defined using an if-then clause, you must use the function plotting
command:

> f:=x-> if x<3 then x+1 else -x"2+13 fi:
plot (£ (x) ,x=0..5);

Error, (in f) cannot evaluate boolean
The error resulted because Maple attempts to understand the expression f (x) before it has

a value for x. One way around this!* is to use the command
> plot(f, 0..5);

-10] \

-121 '

You can see from the graph that the function f is probably continuous but not differentiable
at x=3.

10 Exercises

1. Evaluate 7V2 to 30 decimal places.

2. Input the following as a Maple function:
f(z) = VZ(—1162° + 8z* + 55822 — 891x)
225 — 2924 4 14023 — 22522

14We could also delay evaluation of f (x) using quotes, with plot (*£(x)’, x=0..5) ;. Alternatively, we could
define f using piecewise, as f:=x-> piecewise(x<3, x+1, -x"2+13);.
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a) Write this in a simpler form (that is, factor and reduce it).

b) Draw the graph of the function for 2 between 0 and 1). Adjust the vertical range so
that some detail can be seen.

¢) Compute the area of the part of the curve that lies above the z-axis and between
x = 0 and x = 5 (that is, integrate the function over the appropriate range of x
values). Give your answer both in actual form and as a decimal approximation to
about 10 places.

d) What is the value of the integral if you remove the factor of \/z from the numerator?
e) Use the derivative of f(z) to determine for what real value = the function has a local

maximum. Use an approximation to about 8 decimal places.

3. Use the commands seq and ithprime to generate a list of the first 20 primes. Compute
the sum of these 20 primes, and give its integer factors.

4. Find the solutions of the system of equations {z? — y? = 4,7 — 2y = 2}.

5. Draw a graph showing both cos z and its fifth Taylor polynomial (that is, 1 — %xQ + ix‘l)
for z between —4 and 4. How many terms do you seem to need to get good agreement in

this range.

Hint: use a variation of the command convert (taylor(cos(x),x,5),polynom) to make
this work.

Think of a suitable way to demonstrate that the approximation you have taken is good.



